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Preface

This documentation describes the installation of Natural on Windows. This also includes the
installation of related products such as Natural Development Server and Natural Security.

Natural is installed using the Software AG Installer, which you download from the Software AG
Empower website at hittps://empower.softwareag.com/.

This documentation provides product-specific instructions for installing Natural. It is intended
for use with Using the Software AG Installer. That guide explains how to prepare your machine to
use the Software AG Installer, and how to use the Software AG Installer and Software AG
Uninstaller to install and uninstall your products. The most up-to-date version of Using the Software
AG Installer is always available at hittp://documentation.softwareag.com/ (Empower login required).

This documentation is organized under the following headings:

What Can be Installed With General information on Natural and the components that can be

Natural? installed with Natural, on Natural Security, and on the required license
files.

System Requirements Supported operating system platforms and prerequisites.

Important Information Important information that you should be aware of before you start

the installation.

Installing Natural How to install Natural (including Natural Runtime, Natural
Development Server, Entire Systems Management and the Natural
Web I/O Interface server) and Natural Security with the Software AG

Installer.
Completing the Installation How to proceed after the installation.
Uninstalling Natural How to uninstall Natural.

For important last-minute information, see the readme file that is provided with Natural. You can
find it in the Natural product documentation at http://documentation.softwareag.com/ (Empower
login required).



https://empower.softwareag.com/
http://documentation.softwareag.com/
http://documentation.softwareag.com/
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at https://documenta-
tion.softwareag.com.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.com with
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.
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About this Documentation

You can find product information on the Software AG Empower Product Support website at ht-
tps://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.aspx and give
us a call.

Software AG Tech Community

You can find documentation and other technical information on the Software AG Tech Community
website at https://techcommunity.softwareag.com. You can:

" Access product documentation, if you have Tech Community credentials. If you do not, you
will need to register and specify "Documentation” as an area of interest.
" Access articles, code samples, demos, and tutorials.

= Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

® Link to external websites that discuss open standards and web technology.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

Installation 3
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What Can be Installed With Natural?

Natural and Natural Runtime

You can install one or both of the following;:

* Natural
This is the full version of Natural. It includes a development environment and a runtime envir-
onment. It also includes the plug-ins which can be used in a Natural Single Point of Development
(SPoD) environment with Natural Development Server (NDV).

® Natural Runtime
This is the runtime-only version of Natural where only a subset of the Natural features is installed.
The runtime environment enables you to execute previously created Natural applications.

Natural and/or Natural Runtime versions can be installed side-by-side. The environments of side-
by-side installations are entirely separate. See also Side-by-Side Installations.

Natural Development Server

Natural Development Server (NDV) enables remote development using Natural Single Point of
Development (SPoD). Natural Development Server needs the Natural development or runtime
environment as a prerequisite.

For further information (including any limitations that may apply for your installation), see the
separate Natural Single Point of Development documentation and the separate Natural Develop-
ment Server documentation. See also the section Remote Development Using SPoD in this Natural
for Windows documentation.

Entire Systems Management

Entire Systems Management needs the Natural development or runtime environment as a pre-
requisite. It consists of the following client products:

® Mainframe Navigation

® Output Management GUI Client

® Entire Operations GUI Client

These client products require additional software on the server. See the documentation of these
products for further information.
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What Can be Installed With Natural?

Natural Web 1/O Interface

The Natural Web I/O Interface is used to execute Natural applications in a web browser and consists
of a server and a client. The server part of the Natural Web I/O Interface needs the Natural devel-
opment or runtime environment as a prerequisite. On Windows, the server is implemented as a
service.

The Natural Web I/O Interface server supports two types of clients: the Natural Web I/O Interface
client for displaying character-based applications in the web browser, and Natural for Ajax for
displaying rich internet applications in the web browser. For more information, see the Natural
Web I/O Interface documentation.

Natural Security

Natural Security enables you to protect your Natural environment against unauthorized access
and improper use. Natural Security runs either as a full version or a runtime version, depending
on the running Natural version. For further information, see the Natural Security documentation
and especially the chapter Natural Security On Different Platforms.

License Files

During the installation of Natural, the Software AG Installer prompts you to enter the path to one
or more valid license files. The license file is an XML file which is delivered by e-mail.

Separate license files are required for the following products:

= Natural

= Natural Runtime

Natural Development Server

Natural Security

] Notes:

1. The Software AG Installer does not check all information in the license file. All license checks
are done, however, when the product itself is started.

2. Natural for Tamino is automatically installed together with the Natural development environ-
ment. It also requires a separate license file. This license file must have the name nxt83.xml. If
you want to use Natural for Tamino, you have to copy this license file manually to the com-
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What Can be Installed With Natural?

mon/conf directory of your installation directory. The Software AG Installer does not provide a
panel for this purpose.
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System Requirements

Supported Operating System Platforms

Natural supports the following 64-bit operating system platforms, both for the Natural development
environment (Natural) and for the Natural runtime environment (Natural Runtime):

® Microsoft Windows 7

® Microsoft Windows 8

® Microsoft Windows 10 Professional and Enterprise

Microsoft Windows Server 2008 R2

® Microsoft Windows Server 2012

Microsoft Windows Server 2016
Home Editions of Microsoft Windows are not supported.

] Notes:

1. We suggest that you install all of the recommended and important Microsoft Windows updates
before you start the installation.

2. On Windows 8.1 and Windows Server 2012 R2 the installation will fail if the Microsoft update
KB2919355 is missing.

Compiler Used to Build Natural

Natural was built and tested with the following compiler:

® Microsoft Visual Studio 2015

Memory Space Requirements

The memory space required by Natural largely depends on the number of users.

The memory space per user is determined by the settings in the parameter file, especially by the
values of profile parameters such as USIZE and SSIZE. By default, Natural is invoked with the
parameter file NATPARM. However, you can also invoke Natural with an alternative parameter file
(by specifying, for example, PARM=myparm).

In addition to the user-specific memory, memory is required for the buffer pool, which is shared
among all users.
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System Requirements

Disk Space Requirements

Approximately 2 GB of hard-disk space is required for Natural (including all Natural and Software
AG Installer packages). This value depends on the installation hardware. On some platforms, it
is higher.

Another 250 MB of hard-disk space is required for Natural Security.

Software Requirements for Using Related Natural Products

The following is required if you want to use related Natural products:

® Entire Access to access SQL databases.

* EntireX when using Natural RPC.

® Entire Net-Work to access remote Adabas database systems.
® Tamino when using Natural for Tamino.

= HTTP server, like Apache or IIS when using the Natural Web Interface.
Natural includes interfaces to:
® Adabas

It is recommended that you use the latest versions of the above listed Software AG products. You
can view all available Software AG product versions and check the dates when their maintenance
ends by visiting Software AG's Empower web site at https://empower.softwareag.com/. Go to
Products > Product Version Availability.

Software Requirements for Natural Security

Natural Security requires:

® Natural (same version and update package or fix as that of Natural Security).
" Adabas.

* Entire Net-Work. Only required if the FSEC system file is located in a remote database. See also
Using Natural Security on Multiple Platforms in the Natural Security documentation.

With the runtime version of Natural Security, the Administrator Services and Maintenance parts
of Natural Security are not available. For the runtime version, it is recommended that an FSEC
database is available by remote access via Entire Net-Work.
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Important Information

Administrator Status

The person performing the installation must have administrator rights.

Installation Directory

During the installation, you are asked to specify an installation directory. Specify the installation
directory in which to install your Software AG products.

We recommend that you use the SoftwareAG directory as the location for Natural and its add-on
products. But any other directory is also possible.

You can only install Natural on a local hard drive on a Windows system. You cannot install Nat-
ural on a network-mounted drive or a SUBST drive.

/\,  Important: It is recommended that you do not install into a directory which is a subdirectory

of a previous installation. Such a previous installation may have been created either with
the Software AG Installer or by an installation tool that was used in the past.

Side-by-Side Installations

You can install the same Natural version more than once on the same machine. And you can also
install several different versions of Natural on the same machine. This may be necessary to test a
new Natural version before it is taken over into a production environment. Each version, however,
must be installed in a separate directory. That is, when Natural is already installed, for example,
in the directory SoftwareAG, you can install a second instance of Natural, for example, in a directory
named SoftwareAG2.

Since Empower only offers the latest version of Natural and other products, it is recommended
that you create and keep an image of installed Natural versions for possible later use. Installing
from an image rather than downloading it from Empower will usually be faster, too. For further
information, see Using the Software AG Installer.

There is one exception: the plug-ins and the terminal emulation which are installed together with
the development environment can only be installed once on one machine. Therefore, they are in-
stalled into a common Natural directory outside of the above-mentioned installation directory.
You can find them in \ Program Files\ Common Files\ Software AG\ Natural (32-bit machines) or

\ Program Files (x86)\ Common Files\ Software AG\ Natural (64-bit machines). When you install a
second instance of Natural, the installer checks whether the plug-ins and the terminal emulation

14 Installation



Important Information

in the common Natural directory are older than the ones to be installed. If they are older, they will
be replaced with the new version.

While Natural is being installed, it is not possible for another user to install Natural on the same
machine. A message with the following information will then be shown: the name of the user who
is currently installing Natural, when this installation has been started, and into which directory
Natural is currently being installed.

A side-by-side installation of the Natural development environment is only possible if Natural is
currently not being used. This is to ensure that the plug-in and terminal emulation files in the
common Natural directory can be replaced, if required. A message will be shown with the inform-
ation that any active Natural sessions need to be closed first. In addition, it is not possible to do a
side-by-side installation of Natural if the content of the common Natural directory is currently
shown in the Windows Explorer.

Upgrading Your Natural or Natural Runtime Environment

When one of the first two digits of the version number changes, we consider an installation as an
upgrade installation.

It is not possible to upgrade an existing Natural Version 6.3 or Natural Runtime Version 6.3 with
a Natural Version 8.4 installation.

Updating Your Natural or Natural Runtime Environment

When the first two digits of the version number remain the same and the third or fourth digit
changes, we consider an installation as an update installation.

To update Natural, specify the same directory and select the same items to install.

Anupdate installation does not prompt again for license files, configuration data, and port numbers.
The existing license files, configuration data, and port numbers will be used.
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Important Information

FNAT Usage

By default, a new FNAT is created in the installation directory during the installation of Natural
(<install-dir>/Natural/fnat). This FNAT must always exist, and the global configuration file must
have an entry which defines this FNAT.

The Natural add-ons (such as Predict or Natural Business Services) can only be installed into this
FNAT.

| Note: If you want to check or edit the settings in the global configuration file, use the Con-
figuration Utility.

The Software AG Installer maintains an internal list of installed products, which must coincide
with the add-ons that are currently installed in the FNAT. This is important for updates and unin-
stallations to work correctly.

For this reason:

* Do not install products into the FNAT without the use of the Software AG Installer.
® Do not replace the default FNAT (<install-dir>/Natural/fnat) with another FNAT.

" Make sure to complete the installation of an add-on by using the SYSPCI utility.

If an error occurs due to the above-mentioned scenarios, the only way to solve the problem is a
new installation. In some situations, one of the following workarounds may help:

® Workaround 1: Complete the previous installation by using the SYSPCI utility.

® Workaround 2: Uninstall the product and then start the installation once more.

FUSER Usage

By default, a new FUSERis created in the installation directory during the installation. If you want
to use an existing FUSER of Natural Version 6.3, you have to adjust the system file settings in the
global configuration file after the installation. See also Overview of Configuration File Parameters in
the Configuration Utility documentation.
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Important Information

Natural Security

You can install both Natural and Natural Security at the same time, or you can install Natural Se-
curity after having installed Natural.

To become operable, Natural Security requires a post-installation configuration and initialization
step. This includes:

" setting or loading the Natural Security log file,

" setting or loading the Natural Security file FSEC,

® adjusting the Natural parameter files,

* adjusting the global configuration file.

See also Setting Up Your Products Using the SYSPCI Utility in the section Completing the Installation.
This step is not necessary after an update installation.

The following restrictions apply if you install Natural Security together with Natural Runtime:

® It is only possible to use an existing Natural Security FSEC file.

" Once you have installed Natural Security, it is not possible to access the SYSSEC application,
even if you are a Natural Security administrator.

A\  Important: Once you have installed and configured Natural Security, Natural on the assigned

system file (FNAT) can only be accessed under the control of Natural Security. Natural Security
cannot be removed once it has been installed. It can only be removed if you uninstall the
whole Natural environment in which Natural Security has been installed.
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Installing Natural

Using the GUI to Install Natural

This installation documentation provides just a brief description on how to install Natural directly
on the target machine using the Software AG Installer GUI. For detailed information on the Software
AG Installer, see Using the Software AG Installer.

A

Important: Make sure all ports you specify on panels or in response to prompts are not

already being used by other products on your machine. The installer cannot detect whether
ports are in use when products are shut down, and the shutting down of products is a re-
quirement for running the installer. For a list of default ports used by Software AG products,
see "List of Used TCP/IP Ports" in Empower (go to Products > Download Components >
TCP/IP Ports).

> To install Natural

Software AG provides one or more license files for Natural; the installer requires them during a

first-time installation. Copy the license files to the machine on which you want to install Natural.
You can copy the license files to any temporary location. The installer will ask for the location of
your license files and will then copy them to the common/conf directory of your installation directory.

1
2

Start the Software AG Installer GUI as described in Using the Software AG Installer.

When the first page of the Software AG Installer GUI (the so-called Welcome panel) is shown,
choose the Next button repeatedly (and specify all required information on the shown panels
as described in Using the Software AG Installer) until the panel containing the product selection
tree appears. This tree lists the products you have licensed and which can be installed on the
operating system of the machine on which you are installing.

To install Natural with all of its product components, expand the Natural Products node and
select Natural.

Or:
Expand Natural Products > Natural and select the product components that you want to install.

If you select a single Natural product component, the installer automatically selects any addi-
tional components which are also required. However, it does not automatically select Runtime
Environment or Development Environment because it cannot know which environment you
intend to install. Therefore, if you select, for example, Trace and Debug Files, you also have
to select the environment that you want to install.

20
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f N
3 Software AG Installer E‘Elﬂ

SOFTWARE AG Installer

=Proxy =*Re ;e =+Directory =*Products —*Languages =*Lic

Select products to install.
If language packs are available for selected products, you will be able to select language packs later.

® &

=~ Adabas Products
I~ Designer
Il -~ Documentation
|| &% Infrastructure
=¥ Matural Products
BT Application Engineering
-7 Entire Systems Management
| =W Matural
I¥ Shared Components 8.4 SP1
¥ Runtime Environment 8.4 SP1
I¥ Development Environment 8.4 SP1
I¥ Development Server 8.4 5P1
I¥ Entire Systems Management 8.4 SP1
I¥ Trace and Debug Files 8.4 SP1
----- ¥ Web /0 Interface 8.4 5P1
-[~ Matural for Ajax 8.4 SP1
-[~ Matural Security 8.4 SP1

Selected Release:
|| Installed Release:
Product Size:
Total Download Size: 434 MB
Free Space Required: 368 MB
Free Space Available: 181097 MB
[ = Back ] l Mext = l [ Cancel ]

b

] Note: Products or product versions which are already installed in the selected installation

directory are shown as disabled.
The following product components are available:

® Shared Components
Installs the shared components for Natural Runtime, Natural and Natural Development

Server.

* Runtime Environment
Installs the local runtime environment for Natural Runtime or Natural. You can install this
if you have a license file for Natural Runtime. You will be prompted to provide the license
file later during the installation (first-time installation only). Or you can install this if you
have a license file for Natural and you install the development environment. In this case,
the runtime environment is automatically installed.
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Installing Natural

* Development Environment
Installs the local development environment for Natural. This also includes the Natural
Studio plug-ins for remote development using Natural Single Point of Development (SPoD).
You can install this if you have a license file for Natural. You will be prompted to provide
the license file later during the installation (first-time installation only).

* Development Server
Installs Natural Development Server (NDV) which enables remote development using
Natural Single Point of Development (SPoD). This component requires an additional license
file. You will be prompted to provide the license file later during the installation (first-time
installation only).

* Entire Systems Management
Installs the following clients:

® Mainframe Navigation
® Output Management GUI Client
® Entire Operations GUI Client

* Trace and Debug Files
Installs the Natural binaries for tracing and debugging.

* Web I/O Interface
Installs the server part of the Natural Web I/O Interface. This enables you to use a browser
as the I/O device for Natural applications.

If you want to install Natural Security, select Natural Products > Natural Security 8.4 SPnin
the product selection tree. Natural Security can only be installed together with Natural (either
with the development environment or the runtime environment) or after the Natural install-
ation is complete.

Note: If user authentication via an LDAP server is to be used, it is required that the SSX

security libraries (Infrastructure > Libraries > Security Libraries) are installed as part
of the Natural Security installation procedure. By default, if you select Natural Security
in the installation tree, the SSX security libraries are automatically selected also. Refer
to Authentication Options in the section Administrator Services of the Natural Security
documentation for further details.

Choose the Next button.

Read the license agreement, select the check box to agree to the terms of the license agreement,
and choose the Next button.

First-time installation only.

Enter the full path to the Natural license file or to the Natural Runtime license file (or use the
Browse button to select it from a dialog box).

For example, the following is shown when you install the full version of Natural.

22
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Installing Natural

2 Software AG Installer | O

5 software~ Software AG Installer bout
=»Proxy =R =Directory =*Products =-*Languages =*License -*Configure -*Confirm =*Install
Natural Development Environment

License file:

Matural configuration data
@ Create default configuration data
() Reuse configuration data from the current installation directory
(") Copy configuration data from another installation directory:

Directory: Browse...

[ < Back ]| Next = |[ Cancel

It is only possible to reuse or copy configuration data from a Natural installation which has
been installed with the Software AG Installer.

Create default configuration data
Default. All required configuration files are created. These files contain default values.

Reuse configuration data from the current installation directory
This option is helpful, if you want to reuse the configuration files from a previous unin-
stallation in the same directory.

Copy configuration data from another installation directory
This option is helpful if you have side-by-side installations. In this case, you can copy the
configuration files from an existing Natural installation directory into the current directory.
The existing Natural installation remains unchanged. Enter the full path to the existing
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Installing Natural

root directory (or use the Browse button to select the root directory from a dialog box).
At least the NATURAL.INI file is expected in this case.

The following configuration files are reused or copied:

<install-dir>/Natural/ett/NATURAL.INI''

<install-dir>/Natural/etc/ NATCONV.INI
<install-dir>Natural/etc/NATCONE.CFG*

<install-dir>Naturallprofl

All Natural text members INST-<productcode> within the library SYSPCI

Notes:

' A new default buffer pool NATBP is created, and the buffer pool parameter READONLY is set
to NO. Other buffer pool parameters are kept.

>The paths of the default system files (99,100 and 99,101) are adapted to the current installation
directory.

* All files except NDVSERVER.PRU.
Choose the Next button.

First-time installation only: When Development Server was selected in the product selection
tree, enter the full path to the Natural Development Server license file (or use the Browse
button to select it from a dialog box). You can enter a different value for the Natural Develop-
ment Server port. Values between 1023 and 65536 are valid. The default value is 2700. If this
port is already used, the number of the next free port will be shown.

24
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Installing Natural

.
ﬁ Software AG Installer

5 software~ Software AG Installer

=+Proxy -*Release =*Directory -*Products =+Languages

Hatural Development Server
License file:
Port: |2700

< Back ]| Next = |[ Cancel

10 Choose the Next button.

11  First-time installation only: When Web I/O Interface was selected in the product selection
tree, you can enter a different value for the port. This port is used by the Natural Web I/O
Interface service. Values between 1023 and 65536 are valid. The default value is 2900. If this
port is already used, the number of the next free port will be shown.
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12
13

”
ﬁ Software AG Installer

6 software~ SoOftware AG Installer
=+Proxy -*Release —*Directory -*Products -*Languages -*License -*Configure —+Confirm -*Install

Natural Web IO Interface

Port: (2900

[ < Back ]| Net = |[ Cancel

Choose the Next button.

First-time installation only: When Natural Security was selected in the product selection tree,
enter the full path to the Natural Security license file (or use the Browse button to select it
from a dialog box).
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—mﬁlg

5 software~ Software AG Installer About

’
ﬂ Software AG Installer

=+Proxy -*Release —*Directory -*Products -*Languages -*License -*Configure —+Confirm -*Install

Hatural Security

License file: Browse. .

< Back ]| Next = |[ Cancel

14 Choose the Next button.

15 On the last panel, review the list of products and items you have selected for installation. If
the list is correct, choose the Next button to start the installation process.

When the Software AG Installer has completed the first-time installation, additional configur-
ation steps are required. See Completing the Installation for further details.
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Using Software Distribution Tools to Install Natural

You can use the Software AG Installer to create an installation package which can then be distributed
automatically to any number of computers in your environment. You can use third-party distribu-
tion tools for this purpose.

To distribute Natural, the following items are required:

Software AG Installer.
Installer image containing the products to be installed.

Script file which defines the location of the image file, the products to be installed, and the loc-

ations of all required license files.

License files for the products to be installed.

The description below just provides a brief overview on how to create the required files. For more
detailed information, see Using the Software AG Installer.

~ To create the image and script

1  Start the Software AG Installer GUI as described in Using the Software AG Installer.

2 On the Welcome panel, choose the Advanced Options button.

3  Go to the Images tab and proceed as follows:

1.
2.
3.

Select the Use installation image check box.
Select the Create image option button.

Specify alocation and name for the image. The installer will automatically add the extension

ZIp.

. Specify the platform for which you want to create the image. You can create an image for

any platform from any platform.

. Choose the OK button to return to the Welcome panel.

4  Choose the Next button repeatedly in order to:

1.
2.
3.

Select the products to be installed.
Agree to the terms of the license agreement.

Start the installation to create the image.

Note: When creating an image, the panels on which you usually specify the license files
and ports do not appear.
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5  Start the Software AG Installer GUI once more, and choose the Advanced Options button
again.

6  Go to the Images tab again and proceed as follows:

1.
2.
3.

Select the Use installation image check box.
Select the Install from image option button.

Specify the name of the image that you have previously created.

7 Go to the Scripts tab and proceed as follows:

1.
2.
3.

Select the Use installation script check box.
Select the Create script option button.

Select the Do not install products on local machine option button, unless you also want
to install on the local machine in the same step.

. Specify a location and name for the script.

. Choose the OK button to return to the Welcome panel.

8  Choose the Next button repeatedly in order to:

1. Specify the installation directory.

2. Select the products to be installed.
3.
4

Agree to the terms of the license agreement.

. First-time installation only: Specify the paths to all required license files and, if required,

specify the ports for the selected products.

Start the installation to create the script.

Note: It is recommended that you create separate scripts for first-time installations

and update installations.

~ To adapt the script

1 Edit the script that you have previously created and adjust the references to the image and
license files. For example:
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guiNscLicense=__VERSIONI1__,C%3A%5CUsers%5Cxyz%5CDocuments%5CLics%5Cnsc84 . WinDesk.2017 . xm]l
guiNatLicense=__VERSIONI_ ,C%3A%5CUsers%5Cxyt%5CDocumentss5CLics%5Crun84WinDesk. 2017 . xml
imageFile=C\:\\Users\\xyz\\Documents\\NaturalSec84.zip

For an automated installation, the references to the image and license files need to be adjusted
to the actual installation location. You can specify either the full path or a relative path such
as file-name, \\ file-nameor.\\folder-name\ file-name.You can also specify the full path
toafileserver suchas \\\\ file-server\\ folder-name\ file-name. The following examples
show the different ways in which a path can be specified:

guiNscLicense=__VERSION1__ ,nsc84.WinDesk.2017.xml
guiNscLicense=__ VERSIONI_ , .\\Lics\\nsc84.WinDesk.2017.xml
guiNscLicense=__ VERSIONI__ ,\\\\ServerI\\Lics\\nsc84.WinDesk.2017.xml

You also can use environment variables as part of the path specification. For example:
imageFile=$IMAGEDIR$\\NaturalSec84.zip

2 If necessary, adjust the parameter values in the script (for example, port numbers).

| Note: You can delete the port specification lines for Natural Development Server

(guiNdvPort=..)and the Natural Web I/O Interface (guiWebioPort=..) from the script
if you want to make sure that the installation does not stop if the specified port number
is in use. In this case, the next free port number will be used.

> To start the installation

m  Start the installation from the command line. Start the installer jar file as follows:

java -jar SoftwareAGInstaller.jar -readScript script-file-name <
-scriptErrorInteract no

Alternatively, you can use the installer exe file. In this case, you have to set the environment
variable ZFUSTON_INSTALL_ARGS to the required installer options:

set ZFUSION_INSTALL_ARGS=-readScript fullpath\script-file-name <
-scriptErrorInteract no
SoftwareAGInstaller.exe

| Note: An appropriate Java version must be installed on the machine when using the

jar file. A Java installation is not required when using the exe file.
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= Windows User Group .........cooovvvvivviirieeeeeenninnne,
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= Setting Up Your Products Using the SYSPCI Utility

= |nvoking the SYSPCI Utility ..o,
= Setting Up the Additional Natural Components ......
= Setting Up Natural Security ..o,
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Windows User Group

The Natural installation creates a local Windows user group with the name "SAG Natural Users".
The user "EVERYONE" is assigned to this user group by default.

When the Windows user group "SAG Natural Users" is created, you have to reboot your machine
when the installation finishes. When this user group has already been created (due to a previous
installation), this reboot is not required.

The user group "SAG Natural Users" receives full write permissions for all installed objects. Due
to the user "EVERYONE", all users have write permissions for all installed objects. You can limit
these permissions by removing the user "EVERYONE" from the user group "SAG Natural Users",
and then manually adding all required users to this group. To do so, go to Control Panel > System
and Security > Administrative Tools > Computer Management; in the resulting window, select
Local Users and Groups.

Entries in the Start Menu

Depending on your selection in the product selection tree, some or all of the following entries have
been created in the Windows Start menu:

® Under All Programs > Software AG > Administration:

ESM Configuration for Natural n.n
Natural Buffer Pool Monitor n.n
Natural Component Browser n.n
Natural Configuration Utility n.n

® Under All Programs > Software AG > Tools:
Natural n.n

Natural Runtime n.n
Entire Systems Management for Natural n.n

= All Programs > Software AG > Documentation

where n.n stands for the current version number. The Start menu group name (by default, this is
"Software AG") can be changed during the installation.
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Setting Up Your Products Using the SYSPCI Utility

After you have installed your product, you need to set up a number of files, parameters and indi-
vidual settings depending on your environment. These are described below. To set them up, you
use the SYSPCI utility. For detailed information on this utility, see SYSPCI Utility - Product Config-
uration and Initialization in Natural's Tools and Ultilities documentation.

The Natural Command Processor requires an NCP file.
Natural Security requires an Adabas FSEC system file.

Natural Security provides the function Logging of Maintenance Functions. If logging is activated,
a Natural Security log file (NSL) is required in Adabas and needs to be set up with the SYSPCI
utility. With this version, you can continue to use your existing Natural Security log file. If you
want to set up a Natural Security log file, it is recommended that you do this before setting up an
FSEC file for Natural Security. In this order, both files can be set up by starting the SYSPCI utility
only once.

The database IDs and file numbers of the new or existing files (FSEC or NCP) that you specify using
the SYSPCI utility are entered into the default parameter files for Natural Security (NSCPARM) and
Natural (NATPARM).

Note: If Natural Security is already active and you use the SYSPCI utility to create a new

FSEC file, database ID and file number are not entered into the current NATPARM and NSCPARM
files.

When you initialize (activate) Natural Security using the SYSPCI utility, the default FNAT system
file from the installation must be used (thatis, <install-d7ir>/Natural/fnat). Otherwise, a subsequent
update installation will not be possible.

The required Adabas files can either be local or remote.

" Remote Access
If the file is located in a remote database, Entire Net-Work must be active and the database must
be accessible.

Note: For Natural Security, see also Using Natural Security on Multiple Platforms in the

Natural Security documentation.

* Existing Local File
Before you start the SYSPCI utility, make sure that the Adabas database containing the required
files is active. With this version, you can continue to use your existing files. No migration of
data from the previous version to the current version is necessary.
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® New File
Before you start the SYSPCI utility, make sure that the Adabas database which will contain the
required files is active. The SYSPCI utility will load and initialize these files. This should be also
done if another file is required for your product.

Before you create new files with the SYSPCI utility, make sure that the ASSO and DATA sizes of
your Adabas database are appropriate for these files. It is therefore recommended that you check
the Adabas .fdu filesin the <install-dir>/<product>INSTALL/<product-code> directory for the
used sizes. If required, change your database setup so that the files can be created.

For Natural Security, for example, the ASSO and DATA sizes are not appropriate if you are using
the default database. The .fdu files for Natural Security can be found in the <install-dir>/Natur-
al/INSTALL/nsc directory.

In addition, make sure that the Adabas nucleus parameters listed in the following table are set for
the database you want to use at database startup. They are not appropriate if you are using the
default nucleus parameters.

LWP Must be at least 1,000,000.
OPTIONS|The option TRUNCATION must be set in the OPTIONS parameter.

Invoking the SYSPCI Utility

In order to invoke the SYSPCI utility, you must first invoke Natural. You can then invoke the
SYSPCI utility using the command line.

~ To invoke the SYSPCI utility

1  From the Windows Start menu, choose All Programs > Software AG > Tools > Natural n.n
to invoke Natural.

2 From the View menu, choose Command Line to switch on the display of the command line.

3  Enter the following command in the command line:

SYSPCI

For more information, see SYSPCI Utility - Product Configuration and Initialization in Natural's
Tools and Ultilities documentation.
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Setting Up the Additional Natural Components

After Natural has been installed for the first time, additional configuration steps are required in
the following cases:

® Natural Development Server
If you have installed Natural Development Server (NDV), see the description of the appropriate
NDYV server in the Natural Single Point of Development (SPoD) documentation for further in-
formation. This documentation is available separately.

® SPoD-Specific Features
If have installed the development environment and you want to use plug-ins which make up
the Natural development client for SPoD, see the descriptions of the appropriate SPoD-specific
features in the Natural Single Point of Development documentation for further information.
This documentation is available separately.

* Entire Systems Management
Entire Systems Management requires additional software on the server. If you have installed
the Entire Systems Management clients, you have to initialize the clients before you can use
them. To do so, choose All Programs > Software AG > Administration > ESM Configuration
for Natural n.n from the Windows Start menu. In the resulting dialog box, you can select
whether to initialize or remove a client. Only initialized clients will be shown in the Entire Systems
Management application window. See the following documentation sets for further information
- these documentation sets are available separately:

® Mainframe Navigation documentation
® Output Management GUI Client documentation
® Entire Operations GUI Client documentation

* Natural Web I/O Interface
If you have installed the Natural Web I/O Interface, see the Natural Web 1/O Interface document-
ation for information on how to configure the server part (that is, the service), and how to install
and configure the Natural Web I/O Interface client. If you want to use Natural for Ajax as the
client, see the Natural for Ajax documentation. This documentation is available separately.

Setting Up Natural Security

If you have installed the Natural Security runtime version, no further steps are required.

The initial installation of Natural Security results in the creation of the following security profiles
and relationships:

® A library security profile with library ID SYSSEC. The library is people-protected (People-pro-
tected set to "Y" and Terminal-protected set to "N").
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" A user security profile with user ID "DBA", user type "ADMINISTRATOR", and password set
to "DBA".

" User "DBA" is linked to library SYSSEC (ordinary link, no special link).

If there is a previously installed version of Natural Security, these two security profiles will not
be modified by a subsequent installation, nor will any objects or relationships already defined be
affected.

If you have installed the full version of Natural Security for the very first time (that is, if the version
you have installed is your first version of Natural Security on this FSEC system file), proceed as
described in the Natural Security documentation under the heading First Steps After the Installation.
Do this immediately after a successful installation of Natural Security.
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7 Uninstalling Natural

You uninstall Natural using the Software AG Uninstaller. For detailed information on how to use
the uninstaller, see the Using the Software AG Installer guide.

In short, you uninstall Natural using the standard uninstall functionality of the Windows. The
Control Panel offers the following entry: Software AG Products: <installation-directory>.
When you choose to uninstall this entry, the Software AG Uninstaller is invoked.

| Note: Natural Security cannot be uninstalled without removing the whole Natural environ-

ment in which Natural Security has been installed.

Exception: the plug-ins and the terminal emulation located in the common Natural directory
cannot be uninstalled using the standard uninstall functionality. These are the files in \ Program
Files\ Common Files\ Software AG\ Natural\V1 (32-bit machines) or \ Program Files (x86)\ Common
Files\ Software AG\ Natural\' V1 (64-bit machines). After you have uninstalled all side-by-side install-
ations of Natural, you can use the batch file Unregister.bat in the V1 directory to remove the plug-
ins, the terminal emulation and the corresponding registry entries. Use the Windows command
Run as administrator to execute the batch file.
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